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Guidelines for Developing Accessible 
Captivate Projects  

Introduction 

Accessibility refers to the design of products, devices, services, or environments for people with 

disabilities. 1The concept of accessible design ensures both “direct access” (i.e. unassisted) and “indirect 

access” meaning compatibility with a person’s assistive technology (for example, computer screen 

readers). Accessibility is about making sure that all people, including those with disabilities, can 

participate in and learn from your eLearning course.  

2Consider these statistics: 

 About 8.1 million people have difficulty seeing, including 2.0 million who are blind or unable to 

see. 

 About 7.6 million people have difficulty hearing, including 1.1 million whose difficulty is severe.  

 About 5.7 million people use a hearing aid.  

 About 19.9 million people have difficulty lifting and grasping, for example grasping a pencil. 

When building online learning courses, it is important to start planning your project with accessibility in 

mind. It will be difficult, if not impossible to take a finished product and make it accessible. The key is to 

plan ahead. 

Accessibility is more than compliance. It is about building a good user experience. You will find that as 

you develop an accessible presentation, every user’s experience will improve, not just individuals with 

disabilities.  

One of the tools DFPS frequently uses to build eLearning products is Adobe Captivate 8. Captivate 8 

products are commonly rendered in these formats: 

 Video 

 Software Simulations 

 Interactions 

 Presentations 

Accessibility requirements apply to all of these formats. 

                                                      
1 (Henry, Shawn Lawton; Abou-Zahra, Shadi; Brewer, Judy (2014). "The Role of Accessibility in a Universal 

Web". Proceeding W4A '14 Proceedings of the 11th Web for All Conference Article No. 17. ISBN 978-1-4503-

2651-3. Retrieved 2016-2-10.) 

 
2 https://www.census.gov/newsroom/releases/archives/miscellaneous/cb12-134.html  

 

http://dl.acm.org/citation.cfm?doid=2596695.2596719
http://dl.acm.org/citation.cfm?doid=2596695.2596719
https://en.wikipedia.org/wiki/International_Standard_Book_Number
https://en.wikipedia.org/wiki/Special:BookSources/978-1-4503-2651-3
https://en.wikipedia.org/wiki/Special:BookSources/978-1-4503-2651-3
https://www.census.gov/newsroom/releases/archives/miscellaneous/cb12-134.html


 

 

Policy 
Federal and state law require that all information and services that we provide to our staff, stakeholders, 

clients and/or the general public be accessible to people with disabilities. The Health and Human 

Services Accessibility Policy and resources can be found at http://accessibility.hhs.texas.gov/policy.asp 

Assistive Technology 
The first step to testing your projects is to become knowledgeable about how assistive technology works. 

Here is a list of assistive technology tools and accommodations for Captivate users with disabilities. 

List of Accessibility Needs  Associated Software 

Vision loss/ no vision Screen reading software (JAWS, NVDA) Screen 
magnification software (ZoomText, Magic) 

Hearing loss/ deaf Synchronized captions 

Cognitive disabilities Predictive spelling software, screen reading 
software 

Physical disabilities Voice recognition software (Dragon), using a 
keyboard without a mouse, specialized keyboards 
Switch controls etc. 

Building Accessibility into your Captivate 
It can be challenging to create an accessible Captivate, but it is possible. Start by building an accessible 

template for all your Captivate products. 

Videos 
When developing accessible videos, Captivate provides a couple of development options. We have 

documented the development process that renders the best results with the least effort. Follow the steps 

to build an accessible template then follow the next steps to create an accessible video.   

1. Write your storyboard, record your narration, and choose supplementary audio tracks. Please 

note that you do not have to include all these elements in your project. You may use one, two, or 

any combination of the three. 

 

2. Open a new Captivate and click on New then on Blank Project to open a new project. Click 

Create. Save your project. 

 
 



 

 

3. Open Publish Settings. 

 
 

4. Select Enable Accessibility.  

 
 

5. Select Start and End. Deselect Autoplay. Click OK. 

 

 



 

 

6. Select Project. Type project description in Description box. Click OK. 

 
7. Choose Video from the Captivate ribbon. Choose Insert Video. 

 
 

8. Click Browse to find your video. Double click your video.  

 

9. Choose Multi-Slide Synchronized Video.Choose Modify slide duration to accommodate 

video. Click OK. Your video will appear on the slide.   

 
10. Click on Video on the Captivate ribbon. Click on Edit Video Timing.  

 
 

 

 

 

 

 

 



 

 

11. Click on Closed Captioning. Click on the plus sign to add text. Enter the text. 

 
 

12. Move a yellow cursor to each key then click the plus sign to add closed captioning that synchs 

with that particular frame of your video. They cursor number corresponds with the row number. 

Add closed captioning for the entire video. 

 
 

13. Open the Skin Editor to build your play bar.  

 
 

14. Customize your play bar. Select Closed Captioning and close the Skin Editor.  

 
 



 

 

15. Click Publish. 

 
 

16. Choose HTML5/SWF from the drop down menu. Choose where you want the video to live. Click 

Publish.  

 
 

17. Click on Yes to view the video and check the closed captioning. 

 
 

18. See the Troubleshooting section of this document if you have any problems.  

 

Software Simulations 
You can build accessible software simulations in Captivate. Start by building an accessible template by 

following these steps.  

1. Write your storyboard and record your narration (if you are using narration). 

 

2. Open a new Captivate and click on New then on Software Simulation to open a new project. 

Click Create. 

 
 

  



 

 

 

 

3. Set the Size: Screen Area and select Recording Type. 

 
4. Set your recording area by moving the red box around the area you want to screencast.  

 
 

5. When you are finished with your software simulation, click the Captivate icon located on your task 

bar. 

 
6. The software simulation opens. Save your project. 

 

7. Open Publish Settings. 

 
 



 

 

8. Select Enable Accessibility.  

 
 

9. Select Start and End. Deselect Autoplay.  

 
 

10. Select Project. Type project description in Description box. Click OK. 

 
 

11. Open the Skin Editor to build your play bar.  

 
 

  



 

 

12. Customize your play bar. Deselect player controls and closed captioning. If you do not use 

closed captioning, you need to make sure that the text on the screen and the narration convey 

the exact same information.  

 
 

13. Determine which call outs you want to appear on the screen. Delete all extra call outs. Screen 

reading software does not read highlight boxes or the mouse.  

 

14. Click on a call out. Open the Properties Panel. Open Accessibility. 

 
 

15. Deselect Auto Label. Leave Accessibility Name and Accessibility Description blank. Click OK. 

 
 

 



 

 

16. Click off the call out. Make sure the side menu shows that you have selected the slide, not the 

callout. Open Accessibility.  

 
 

17. Enter your narration into the Slide Accessibility box or import your slide notes. Click OK. This step 

is very important. Screen reading software will read the slide notes.  

 
 

18. Enter the slide name. Choose a name based on the topic of the slide.   

 
 

19. Repeat steps 1-16 for each slide. 

 

  



 

 

20. Insert an audio, next, and back button to each slide. Click on Interactions. Choose Button from 

the drop down menu. Repeat this step twice. You should have three buttons on your slide. You 

cannot copy and paste buttons. You must insert a new button for each interactive object on you 

slide. If you copy and paste, you will not be able to set tab order.  

 
 

21. Click on each button and decide how you want them to appear by using the style menu. Make 

sure that you pay attention to color contrast. See the Design section of this document under 

General Guidelines. Place the buttons where you want them to appear on the slide. 

 
 

22. Name the buttons by clicking on the button and using the Caption: box to enter the button name. 

Repeat this step for the Audio and the Back button.  

 
 

23. Click on the Options menu on the slide Properties menu.  

 
 



 

 

24. Click on Add Audio. 

 
 

25. Import or record the audio file. Click OK. Click Save. Click Close. 

 
 

26. Make sure the audio button on your screen is selected. Click on Actions. Select Play Audio.

 
 

27. Audio: will appear below the On Success: menu. Click on the folder icon to choose an audio file.  

 
 

 

28. Choose the audio file you want to attach to the audio button. Click OK.

 
 

 



 

 

29. Click off the audio button. Set the slide Properties under Actions to On Enter: Pause and On 

Exit: No Action. 

 
30. Set a logical tab order. Open the drop down menu under slide Properties, next to the Slide name. 

Select Tab Order. 

 
 

31. Use the arrows to arrange the tab order. Set the Audio button first, Next button second, and back 

button third. Click OK. 

 
 

  



 

 

32. Name the buttons using Item Accessibility. Click on the button you want to name. Open the drop 

down menu next to the button name under slide Properties.  

 
33. Deselect Auto Label. Type button name in the Accessibility Name box. Leave the Accessibility 

Description blank. Click OK. 

 
 

34. Publish the slide to ensure the tabbing and buttons work. See the Troubleshooting section of this 

document if you have any problems.  

 

35. Repeat these steps for each slide of your simulation.  

Interactions 
Building accessible interactions in Captivate is possible. You will need to use a few work arounds and will 

need to test and re-test your final product. Follow the steps to create accessible Captivate interactions. 

There are many types of interactions. Apply these steps to the type of interaction you are developing.  

1. Determine what type of interaction you will develop. For this demonstration, we will base our 

instructions upon the development of an interaction with a course menu and a few different types 

of buttons. Start by creating an accessible template. 

 

  



 

 

2. Open Publish Settings. 

 
 

3. Select Enable Accessibility.  

 
 

4. Select Start and End. Deselect Autoplay.  

 
 

5. Select Project. Type project description in Description box. Click OK. 

 
 



 

 

6. Open the Skin Editor to build your play bar.  

 
 

7. Customize your play bar. Deselect player controls. You will add the player controls to each slide. 

Determine whether or not to use closed captioning. If you do not use closed captioning, you need 

to make sure that the text on the screen and the narration convey the exact same information.  

 
 

8. Enter the slide name for each slide. Choose a name based on the slide topic.  

 
 

  



 

 

9. Each slide needs to have a next button, a back button, and an audio button. The captivate player 

is not accessible. You have to create these buttons on each slide. For this demo, we will use 

Captivate default buttons.  

 
 

10. Insert an audio, next, and back button to each slide. Click on Interactions. Choose Button from 

the drop down menu. Repeat this step twice. You should have three buttons on your slide.  

 
 

11. Click on each button and decide how you want them to appear by using the style menu. Place the 

buttons where you want them to appear on the slide. 

 
 

12. Name the buttons by clicking on the button and using the Caption: box to enter the button name. 

Repeat this step for the Audio and the Back button.  

 
 

13. Import your slide narration to the button. Click on the Audio button. Click on the Options menu 

on the slide Properties menu. Click on Options. 

 
 

14. Click on Add Audio. 

 
 



 

 

15. Import or record the audio file. Click OK. Click Save. Click Close. 

 
 

16. Make sure the audio button on your screen is selected. Click on Actions. Select Play Audio.

 
 

17. Audio: will appear below the On Success: menu. Click on the folder icon to choose an audio file.  

 
 

18. Choose the audio file you want to attach to the audio button. Click OK.

 
 

  



 

 

19. Click off the audio button. Set the slide Properties under Actions to On Enter: Pause and On 

Exit: No Action. 



 

 

 

20. Set a logical tab order. Open the drop down menu under slide Properties, next to the Slide name. 

Select Tab Order. 

 
 

21. Use the arrows to arrange the tab order. Set the Audio button first, Next button second, and back 

button third. Click OK. 

 
 

22. Name the buttons using Item Accessibility. Click on the button you want to name. Open the drop 

down menu next to the button name under slide Properties.  

 
 

  



 

 

23. Deselect Auto Label. Type button name  

in the Accessibility Name box. Leave the Accessibility Description blank. Click OK.

 
 

24. Repeat these steps for each interactive element in your presentation.  

 

25. If you choose to use an image instead of a Captivate button, you need to place the image on a 

master slide and place a transparent button over the image on each slide in your presentation. To 

do this, follow the steps in the next section.  

Designing an Interactive Course Menu  
You will follow similar steps when creating your course menu. When designing your course menu, you 

may want to add a background and a few other assets (boxes, lines, pictures) that make the slide look 

interesting. It is important that you add the assets onto a Master slide. This prevents screen reading 

software from reading every single asset on the screen. Do not use the Use as button option. Screen 

reading software cannot detect images used as buttons.  

26. Click on Window on the Captivate ribbon. Choose Slide Master from the drop down menu. 

 
 

  



 

 

27. The Slide Master view opens. Design your course menu. Make sure you do not design on the 

Content Master Slide (the big slide at the top).  

 
 

28. Look at your Slide Properties panel. Make sure the slide it set to Project Background.  

 
 

29. Select all the assets on your screen then right Click. Choose Merge with the background from 

the menu.  

 
 

30. Click Yes. 

 
31. Now that your assets are merged with the background, screen reading software will not read the 

extra and sometimes confusing information that design assets can cause. 

 

  



 

 

32. Click on Exit Master to close the master slides.  

 
 

33. Choose the course menu background you just created from the Slide Properties panel. 

 
  



 

 

34. Place transparent buttons over each interactive object on the screen. Click on Interactions 

located on the Captivate ribbon. Choose Button from the drop down menu. 

 
 

35. Position default button over Next arrow. 

 
 

36. Set the button style to Transparent and delete the button caption on the Slide Properties panel. 

 
 

37. Click on Action in the slide properties panel and set the action to Go to next slide. 

 
 

 



 

 

38. Follow steps 33-36 for each interactive element on your course menu slide. Make sure to 

customize the action for each button. See steps 13-19 to review instructions on how to customize 

the audio button.  

 

39. Name the buttons using Item Accessibility. Click on the button you want to name. Open the 

drop down menu next to the button name under Slide Properties.  

 
 

40. Deselect Auto Label. Type button name in the Accessibility Name box. Leave the Accessibility 

Description blank. Click OK. 

 
 

41. Name the buttons on the Slide Properties panel. Click on each button and change the default 

name to the button name.  

 
 

42. Set a logical tab order. Open the drop down menu under slide Properties, next to the Slide name. 

Select Tab Order. 

 



 

 

43. Use the arrows to arrange the tab order. Set the Audio button first, Section 1 button second, 

Section 2 button third, and so on. Click OK. 

 
 

44. Repeat these steps for each interactive slide in your presentation. Note that you can use 

Captivate default buttons, as outlined in steps 1-24. Steps 26-42 outline the steps to use when 

creating a custom presentation.  

Presentations 
Making ELearning presentations in Captivate is possible. There are best practices to keep in mind. 

Determine if your presentation is going to use audio. Create an accessible template. 

1. Open Publish Settings. 

 

  



 

 

2. Select Enable Accessibility.  

 
 

3. Select Start and End. Deselect Autoplay.  

 
 

4. Select Project. Type project description in Description box. Click OK. 

 
 

5. Open the Skin Editor to build your play bar.  

 
 

  



 

 

6. Customize your play bar. Deselect player controls. You will add the player controls to each slide. 

Determine whether or not to use closed captioning. If you do not use closed captioning, you need 

to make sure that the text on the screen and the narration convey the exact same information.  

 
 

7. Enter the slide name for each slide. Choose a name based on the slide topic.  

 
 

8. Each slide needs to have a next button, a back button, and an audio button. The captivate player 

is not accessible. You have to create these buttons on each slide. For this demo, we will use 

Captivate default buttons.  

 

  



 

 

9. Insert an audio, next, and back button to each slide. Click on Interactions. Choose Button from 

the drop down menu. Repeat this step twice. You should have three buttons on your slide.  

 
 

10. Click on each button and decide how you want them to appear by using the style menu. Place the 

buttons where you want them to appear on the slide. 

 
 

11. Name the buttons by clicking on the button and using the Caption: box to enter the button name. 

Repeat this step for the Audio and the Back button.  

 
 

12. Import your slide narration to the button. Click on the Audio button. Click on the Options menu 

on the slide Properties menu. Click on Options. 

 

13. Click on Add Audio.  

 

14. Import or record the audio file. Click OK. Click Save. Click Close. 

 
 



 

 

15. Make sure the audio button on your screen is selected. Click on Actions. Select Play Audio.

 
 

16. Audio: will appear below the On Success: menu. Click on the folder icon to choose an audio file.  

 
 

17. Choose the audio file you want to attach to the audio button. Click OK.

 
 

18. Click off the audio button. Set the slide Properties under Actions to On Enter: Pause and On 

Exit: No Action. 

 
 

  



 

 

19. Set a logical tab order. Open the drop down menu under slide Properties, next to the Slide name. 

Select Tab Order. 

 
 

20. Use the arrows to arrange the tab order. Set the Audio button first, Next button second, and back 

button third. Click OK. 

 
 

21. Name the buttons using Item Accessibility. Click on the button you want to name. Open the drop 

down menu next to the button name under slide Properties.  

 
 

22. Deselect Auto Label. Type button name in the Accessibility Name box. Leave the Accessibility  

Description blank. Click OK. 

 
 



 

 

23. Repeat these steps for each button in your presentation.  

 

24. Add a text box to the slide. Click on Text and choose Text Caption from the drop down menu. 

 
25. Enter your text. Click on the text box you just created.  

 
 

 

26. Open Accessibility on the Slide Properties panel.  

 
 

27. Deselect Auto Label. Click Ok. 



 

 

 

28. Click off the text box. Open Accessibility in the Slide Properties Panel.  

 
29. Enter the text from your text box into the Slide Accessibility window then click Ok.  

 
 

30. Repeat these steps for each text box in your presentation.  

Adding Shapes and Images 

When you use shapes and images in your presentation, make sure that you use them for aesthetics, not 

to convey meaning. All information must written in text then entered in the Slide Accessibility window. If 

you use shapes or images in your presentation, follow these steps. The steps are the same whether it’s 

an image or a shape.  

 

31. Click on Shapes. Choose a shape from the drop down menu.  



 

 

 

32. Place the shape on the slide. Click on the shape. Open the Accessibility window. Deselect Auto 

Label. Click Ok. 

 
33. Repeat these steps for each image or shape you add to your presentation.  

General Guidelines 

Play Bar  

The Captivate Skin Editor enables you to set the play back controls and the appearance of the progress 

bar. The Skin Editor is located on the Captivate ribbon under the Project menu. When determining how to 

build the skin of your presentation to be accessible, there are best practices to follow based upon your 

project.  

 Eliminate as many player controls as possible. 

 

 You do not need to use closed captioning if the audio matches what is displayed on the screen.  

Be consistent throughout the course in how you use or do not use closed captioning.  

 

 You should use closed captioning in lessons when the complete narration is not displayed on the 

screen. Please note that you can only use closed captioning when audio is imported to the slide.  



 

 

 
 

 Do not use the Captivate generated TOC. It will make the presentation inaccessible. If you need 

to use a TOC, create a course menu slide that enables the learner to navigate through the 

course. Make sure to provide a "home" button on each slide that takes the learner back to the 

course menu.  

 
 

 You may eliminate the play bar controls if you provide controls on the screen but don’t use both. 

 

 The fewer controls, the easier it is for all users to navigate the course. 

 

 Make sure to use a next button and back button on each slide. 

 

 Add a restart or home button on each slide.  

 

 Add an audio button to each slide to give the learner a choice to use either the screen reader 

software or narrator. The slide should pause at start. The audio should be added directly to the 

button and set to play on click. Set the audio button first in the tab order. 

 Audio Button 

 
 

 Button Setting  



 

 

 
 

 Slide Setting 

 

Images and Text Boxes 

 All meaningful information (graphics, text, or software simulation) must have alternate text.  

 

 There are many places to add alternate text in a Captivate presentation. Keep in mind that the 

screen reader will read ALL alternate text. Avoid duplicating unnecessary occurrences of 

alternate text. For example, if you add the text, "next button" to the next button, the screen reader 

will identify the next button as, "next button button."  

 

 If a text box describes an image, put the image on a master slide to prevent the screen reader 

from reading the same information twice.  

 

 Do not import images with text. If you want text on top of an image, create a text box and arrange 

it on top of the image to prevent the text from pixelating for those who use screen magnifying 

software. 

  
 



 

 

 Screen reading software is used by many people who have vision loss. Run tests with screen 

reading software multiple times to ensure that software is only reading what you want read. 

Everyone may access JAWS and all the Microsoft accessibility tools. Submit an EMAC to 

download JAWS. Microsoft Accessibility Tools are located in Control Panel>Ease of Access. 

 

 If there is something for which you do not want alternate text read, such as a decorative line, 

merge the item into the slide background. Click CTRL+M to merge.  

 

Headings 

 Headings must be used in Word documents, LMS pages, and other applicable content that 

supports headings.  

 

 If it is impossible to use built in headings, make sure you build your content in a way that screen 

reading software will read the information in a logical order. Use the alternate text to convey 

headings, subheadings, and/or a list. Double check to make sure the screen reader consistently 

reads the alternate text in the appropriate order. For example:  

If your screen displays a title and sections, the alternate text should read, "Title clouds. Section 

one red fish. Section two blue fish, section three green fish."   

Alternate Text 

 Add a title to your course in the Publish Settings. File>Publish Settings>Project>Project Name 



 

 

 

 Give each slide a title. 

 

 Enter the alternate text into the Slide Accessibility box for each slide. Do not enter extra text in to 

the accessibility description boxes for slide items such as text boxes. Screen reading software will 

read the slide notes.  

 
 

 For slide items such as text boxes, open the accessibility field and unselect “auto label”. Never 

add text in the slide accessibility and in the accessibility boxes per slide item. Screen reading 

software reads both which creates an unnecessarily repetitive experience for the user. Enter the 

accessible text into the slide accessibility box ONLY to prevent possible issues with the screen 

reader and Captivate. This rule also applies to all slide items you place on the master slides 

excluding interactive elements such as buttons.  

 
 

 You must enter text into the accessibility box when using buttons and other interactive items. 

When entering accessibility text on a button, do not enter extra information. For example, do not 



 

 

call the next button, “next button”- call it “next.” Screen reading technology will identify a button as 

a button, or a link as a link, and so on.  

 
 

 The screen reading software does not read highlight boxes. Use them if you’d like but make sure 

that the information the highlight box conveys is also available in the slide notes and in the 

narration.  

 

 Make sure that you spell everything correctly. Screen reading software mispronounces 

misspelled words which creates a bad user experience and inhibits learning.  

Tab Order 

 Set the tab order to begin at the top of the screen so the screen reader will read the slide 

contents in a logical order. 

 
 

 Make sure that each item that can be reached using the tab button is outlined/highlighted so that 

the user receives a visual queue as to where they are on the screen. This is very important for 

people who do not use a mouse.  

 

 Make sure that all active controls or clickable objects can be reached using the tab key.  

 

o If you are having trouble setting tab order, go back into your project, delete the buttons, 

and insert new buttons. Never copy and paste buttons. Insert a new button for each 

interactive object on the slide.  

Buttons 

 Add alternate text to buttons.  

o In Adobe Captivate 8, in order for the keyboard to tab through the buttons, you must use 

a Captivate generated button or place a transparent button over an image you create- 

you cannot convert a shape or image into a button by selecting “Use as button.” If you 

choose to use your own image with a transparent button, paste the image on a master 

slide.  

 



 

 

 Always check the tab order using the keyboard only. The tab order should be intuitive and 

predictable. (Generally, from left to right from the top to the bottom of the slide.) 

 

 Button names should be short yet meaningful. For instance a button that takes the user to Home 

should be titled “Home” not “Button 3.” 

 Do not copy and paste buttons. You must insert a new button for each interactive object on your 

slide. If you copy and paste buttons, you will not be able to set tab order. 

 

 The next button should work with “enter” and “spacebar”. People using assistive technology will 

use the “enter” key to submit. When using Captivate, the enter key is set as default. Do not set 

shortcut key commands- this can cause the slide to become inaccessible.  

 
 The spacebar is standard for pressing a button when using assistive technologies.  

 

 Provide training to participants on how to use the buttons if you set buttons to behave out of the 

norm. 

o Norm:  

 arrow keys are used to move an element that scrolls  

 spacebar presses a button 

 tab key to move between controls and other clickable elements on the screen  

 spacebar to start or move forward 

 enter key to submit or activate a button  

 If you are having trouble making your buttons operate the way you need them to, delete them and 

insert new buttons. Never copy and paste buttons. Insert a new button for each interactive object 

on your slide.  

Learning Interactions 

 When developing an interaction, put the mouse aside and make sure that you can navigate the 

interaction in a logical and intuitive manner. 

 

 Use standard key controls. http://webaim.org/techniques/keyboard/ 

 

 If you do not use normal key controls, provide instructions. 

Universal Symbols 

 Avoid redundancy. Providing too many instructions is confusing. The following buttons are 

universal symbols, and it is not necessary to describe their functions. For example, do not tell the 

user to “click next to continue” at the end of each slide.  

o Play button 

o CC button 

o Next buttons 

o Back buttons 

o Pause button 

o Close button 

o Close browser button 

 

http://webaim.org/techniques/keyboard/


 

 

 Include an accessibility button on each slide and on the LMS homepage that is linked to a 

website or document that provides help for people who are using  assistive technology.  

 

Navigation without a Mouse 

 When developing software demos, it is important to illustrate, visually or through audio, how 

someone will navigate the software without a mouse. This also allows you to test the software 

you are training for accessibility and provides the opportunity to give the developers a heads up if 

the software is not accessible.  

 

 When you create a software demo, you may branch the course into 2 parts- Mouse –users & 

Keyboard Users. Record the demo once, using a mouse, and a second time using keyboard 

controls to complete tasks with the software. Give the user the choice of which demo to enter.  

 

Video 

Video presents some unique challenges when it comes to accessibility. People who are deaf can’t hear 

the audio but can read the screen; and people who are blind can hear the audio but can't see the screen. 

Some videos can move too quickly for those with cognitive disabilities to process. When rendering your 

Captivate project as a video, you must incorporate principles of accessibility.  

 Make sure to enable closed captioning.  

 

 Time the closed captioning to match the audio and the events on the screen. 

 

 Include subtitles and a description of important sounds when appropriate. For example, “(music 

playing) Welcome to your course.” 

 

 Consider providing a text only version of the video. Ensure there is enough information in the text 

to get across your message without images. 

 

 When using text and color in your video, use large text, use colors that are high contrast, and 

leave the text on the screen long enough to be read comfortably.  

 

 Do not set the video to play automatically. Let the user decide when the video starts. 

 

 Don’t use flashing content. Flashing content may cause seizures.  



 

 

Assistive Technology Testing 

 Always test your courses with assistive technologies and with the keyboard without using the 

mouse. 

 

 Turn off your computer screen and make sure that the user can navigate your product using only 

key controls. 

 

 JAWS is available for download but you must submit and EMAC. Click here to submit and EMAC. 

 

 Test your product’s contrast using your computer’s Microsoft Ease of Access Center located in 

the Control Panel. (Push Left SHIFT+Left ALT+ Print Screen to open the Microsoft Ease of 

Access Center.) Click here to open the Web AIM color contrast tool and to read the minimum 

requirements. 

 

 Test your products using the magnifier tool also located in the Ease of Access Center located in 

the Control Panel.  

 

Step by Step Software Demos 

Software simulations are an effective way of teaching your user how to use new applications. When 

building software simulations, there are a few things to keep in mind.  

 Build one step at a time. Pause each slide of the demonstration by adding a next button. This 

also allows the user take time to either listen to the slide audio or the screen reader. 

 

 Allow the user to move backwards so they can review the steps being taught. 

Design 

 Select foreground and background colors that provide a luminosity contrast ratio that exceeds 

4:5:1. There are multiple color contrast checkers online. Click here to visit the online tool.  

 Make sure your images are placed far enough apart as to allow assistive technology to zoom in 

and out. 

 

 Do not convert text to pictures to avoid pixilation.  

 

 Make sure that the text on the screen, alternate text, and narration say the same thing.  

 

Best Practices  
 Offer choices. Learning is more effective when the learner is in control of their learning.  

 Do not take away player or browser controls or “lock” people into a course. This creates barriers 

for assistive technology, keyboard users, and other people who need custom browser settings. 

 

http://intranet.dfps.txnet.state.tx.us/Application/eMAC/WebPages/HomePage.aspx
http://webaim.org/resources/contrastchecker/
http://webaim.org/resources/contrastchecker/


 

 

 Do not lock browsers or dimensions of the player screen. This creates barriers for assistive 

technology and for people who need to use their browser to increase the size of the text or the 

images.  

 

 You may offer two versions, one accessible and one not, in one course. Use branching to allow 

the user to choose one path or the other. Only do this if you have exhausted all other options.  

 

 Use plain language and eliminate unnecessary narration. For example, instead of describing 

where a link is located on the screen, just add a call out and tell them to click the link.  
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